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RESUMEN 

 

En este trabajo se estudia un sistema macroscópico de partículas esféricas bajo un campo magnético 

dependiente del tiempo, constituyéndose un sistema que comparte características con fluidos 

moleculares, vidrios y cristales. En particular, el movimiento de las partículas macroscópicas en el 

modelo presenta algunas similitudes con el movimiento de los átomos y moléculas en los sistemas 

formadores de vidrio o cristales. Para inducir la cristalización se realizó una modificación de la 

configuración experimental usada previamente en el estudio de sistemas vítreos, ésta consiste en 

el cambio de la geometría de la superficie, en vez de usar una forma plana, se usa una superficie 

curva la cual provoca que el sistema de partículas interactúe con un potencial parabólico. Para 

producir la temperatura efectiva del sistema se usó un campo magnético senoidal, el cual confiere 

a las partículas energía cinética de forma continua. Se utilizan diferentes rapideces de enfriamiento 

en un intervalo de 2 G/s a 0.02 G/s. Se observa que al enfriarse el sistema rápidamente se obtienen 

estructuras sin orden aparente, pero cuando el enfriamiento es prolongado se logra la cristalización. 

Los resultados experimentales se analizaron mediante cantidades que comúnmente se usan en este 

tipo de modelos, como la función radial de distribución y el desplazamiento cuadrático medio. 

También se examinaron las distribuciones de las áreas de los polígonos de Voronoi.  
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INTRODUCCIÓN 

 

La cristalización es uno de los procesos más relevantes que ocurren en la naturaleza y en la vida 

diaria. Ejemplo de ello es la formación de hielo y de algunos minerales en la atmosfera, también 

se observa en aplicaciones tecnológicas, en las industrias farmacéutica, alimentaria y metalúrgica, 

entre otras. Los cristales son definidos como sólidos con una disposición molecular ordenada y 

periódica. Para obtenerlos a partir de sistemas fluidos es necesario cumplir ciertas condiciones, una 

de ellas es que debe existir una transición de fase lenta y uniforme a través de un lento enfriamiento, 

ya que si se da un enfriamiento súbito se obtendrán estructuras amorfas. Es muy importante estudiar 

cada una de las etapas en el proceso de cristalización debido a que muchas de las propiedades de 

los cristales como el ordenamiento, forma y tamaño, dependen de las condiciones en las que se 

llevan a cabo, en particular la nucleación y el crecimiento.  

 

Desde hace varias décadas los científicos han intentado explicar lo que ocurre a nivel molecular 

durante la transición vítrea o cristalina. Por ello, mediante el uso de algunas técnicas indirectas que 

emplean radiación electromagnética y usando la mecánica estadística, se obtienen cantidades como 

la función de distribución radial y la función de dispersión intermedia, las cuales aportan 

información sobre la estructura y dinámica de este tipo de sistemas. Sin embargo, dar una 

descripción completa de cómo evoluciona el proceso es muy complicado debido a que rastrear un 

conjunto de partículas en un fluido a escala molecular implica el uso de tecnología aún no 

desarrollada. De ahí que surja la necesidad de buscar modelos que den una explicación más 

profunda.  

 

En el presente trabajo se estudia un sistema macroscópico de partículas esféricas bajo un campo 

magnético dependiente del tiempo, en el cual la energía cinética de las partículas se controla 

mediante la amplitud del campo magnético y por lo tanto se logra un control de la temperatura 

efectiva. El campo magnético es análogo a un baño térmico en un sistema real. También este 

sistema podría modelar un proceso de evaporación de solvente y la respectiva agregación de las 

partículas suspendidas para formar cristales o vidrios. En este caso el campo magnético controlaría 

la velocidad de evaporación. 
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El principal objetivo de este trabajo de Tesis es estudiar el proceso de cristalización de un 

sistema de partículas esféricas por medio de un modelo macroscópico, donde pueden seguirse 

las trayectorias de cada una ellas, analizando cantidades estructurales y dinámicas promedio 

que se obtienen a partir de la información experimental, para caracterizar la estructura y 

dinámica local del sistema. Esto es posible porque el proceso sucede a nivel macroscópico y en 

escalas de tiempo accesibles experimentalmente. Los movimientos pueden ser grabados con 

suficiente resolución y se pueden calcular directamente ciertos parámetros que para sistemas 

moleculares es imposible. Esto se debe a que a nivel molecular el tamaño de las partículas 

típicamente es del orden de nanómetros y la velocidad con la que se desplazan es alta, de tal manera 

que para poder rastrearlas es necesaria una resolución temporal de milisegundos. Además, el 

estudio de sistemas macroscópicos para analizar los procesos de solidificación ofrece una ventaja 

adicional, se pueden examinar y calcular cantidades dinámicas de cada una de las partículas y luego 

determinar las distribuciones de estas cantidades, no solo sus promedios.  

 

El documento se organiza de la siguiente manera. El Capítulo 1 está destinado a la recopilación de 

antecedentes sobre la cristalización, repasar los modelos utilizados para estudiar este proceso, y 

describir las herramientas de análisis que se usan en este trabajo. En el Capítulo 2 se describe la 

configuración experimental utilizada, el procedimiento implementado y los resultados obtenidos 

de las cantidades estructurales y dinámicas. En el Capítulo 3 se analiza el efecto de perturbaciones 

externas en la cristalización, lo cual implica pequeñas modificaciones al procedimiento 

experimental, obteniéndose resultados interesantes. Por último, se presentan las conclusiones y 

perspectivas del trabajo. 
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CAPÍTULO I 

 

ANTECEDENTES 

 

 

I.1 CRISTALIZACIÓN 

 

La cristalización es un proceso que ocurre cuando un medio fluido es enfriado lentamente hasta 

temperaturas por debajo de la temperatura de solidificación. Este fenómeno se produce cuando se 

dan las condiciones necesarias para generar regularidad y orden entre las moléculas, átomos o 

iones. Se puede definir un “cristal” como un sólido con alto índice de regularidad en las moléculas 

que lo integran (Mullin, 2014). 

 

Cuando las moléculas carecen de orden y se distribuyen aleatoriamente, el sistema está en un estado 

gaseoso o líquido, dependiendo de la estructura en particular que adopten las moléculas. Cuando 

existe un arreglo entre moléculas circunvecinas y luego estas continúan con un arreglo distinto en 

otra dirección tenemos un sistema con un orden de corto alcance, propio de materiales amorfos. En 

cambio, este arreglo puede llamarse de largo alcance si el patrón inicial de átomos se repite en todo 

el material, formando una red reticular que para cada material es distinta de acuerdo con el tamaño 

de los átomos y el enlace interatómico (Askeland D. R., 1987).  

 

Una estructura cristalina describe la manera en que se ordenan los átomos dentro de la red. Se han 

determinado siete sistemas de estructura cristalina que puede adoptar un material y que determinan 

su comportamiento, el siguiente esquema los ilustra (fig. 1.1). En algunos casos un material puede 

presentar más de una estructura cristalina, en este caso se dice que el material es alotrópico. Por 

ejemplo, el hierro tiene más de una estructura cristalina y por lo tanto es alotrópico. A temperaturas 

bajas posee una estructura cristalina centrada en el cuerpo, pero a temperaturas altas es una 

estructura cristalina cúbica centrada en las caras, esto permite elegir el tipo de tratamiento térmico 

a utilizar según su aplicación (Askeland D. , 1998). 
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Figura 1.1: (a) Los siete sistemas de estructura cristalina, (b) tabla de las características de los siete sistemas 

cristalinos. Esquemas extraídos del libro Ciencia e Ingeniería de los materiales, Donald R. Askeland, Tercera 

Edición. 

 

Aunque podría pensarse que algunos materiales son perfectos, la realidad es que todos tienen 

irregularidades en su estructura cristalina, estos defectos ocasionan cambios en el comportamiento 

del material y son aprovechados para una infinidad de aplicaciones. Las dislocaciones implican un 

deslizamiento de los átomos en la red, que en el caso de los metales les permite ser deformados sin 

que se fracturen. Los defectos puntuales abordan irregularidades en la disposición de los átomos, 

por ejemplo, la existencia de espacios vacíos en la red se denominan vacancias, éstas pueden ser 

utilizadas para dopar materiales. Los defectos de superficie se originan cuando existen límites que 

separan regiones con un ordenamiento general de corto alcance, es decir, los átomos siguen un 

mismo patrón hasta llegar al borde delimitante y al terminar este, el arreglo se da en otra dirección.  

 

Los defectos estructurales son empleados en el desarrollo de nuevos materiales, ya que estos 

permiten realizar modificaciones en sus propiedades. Es posible aumentar la resistencia, variar la 

capacidad térmica y conductividad eléctrica, regular la ductilidad en metales e incluso la presencia 

de impurezas pueden cambiar el color en vidrios o polímeros. Por lo que se pone de manifiesto la 

importancia de poder controlar las etapas de procesamiento de los materiales, ya que de esto 

dependerá su aplicación final y si se ha cumplido con el propósito de su creación (Askeland D. R., 

1987).  

 

(a) (b) 
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El proceso de cristalización inicia con la nucleación, en esta etapa se genera una pequeña semilla 

dentro del líquido que actúa como foco central del proceso de crecimiento. La nucleación requiere 

ciertas condiciones para efectuarse, la temperatura y el número de átomos deben ser los adecuados 

para que se formen el conglomerado inicial. Además, es necesario sobrepasar un determinado radio 

crítico, ya que de no ser así el núcleo podría ser destruido por variaciones térmicas (A. F. Heneghan 

& A. D. J. Haymet, 2002).  

 

La nucleación homogénea se origina cuando se ha formado una semilla con mayor tamaño que el 

considerado como crítico, a partir de ella se formará un sólido estable. Por otra parte, la nucleación 

heterogénea se da cuando la semilla se construye en la superficie de impurezas que están en 

contacto con la fase líquida o con las paredes del recipiente. Posteriormente a la formación de un 

núcleo, surge el crecimiento, en donde las partículas se agregan siguiendo el patrón inicial hasta 

que el sistema ha adquirido las características de un sólido. En este punto la temperatura se ha 

equilibrado en todo el sistema al igual que la energía, y las moléculas han conseguido un arreglo 

estable y uniforme dando origen a un sólido cristalino estable (Askeland D. R., 1987).  

 

Uno de los métodos más efectivos para inducir la cristalización es la siembra de semillas (pequeños 

agregados de partículas) en el material a solidificar. Esta técnica se utiliza comúnmente en la 

industria, ya que es posible controlar ciertos parámetros, como el tamaño y la forma del cristal. 

Además, el proceso es optimizado debido a que la nucleación espontanea requiere de mayor energía 

que el crecimiento, lo que se traduce en una reducción de tiempo para obtener un cristal (Bergfors, 

2003). 

 

Así mismo es posible reacomodar los defectos contenidos en estructuras cristalinas a un arreglo 

totalmente ordenado mediante la recristalización, la cual se da colocando los sólidos cristalinos en 

un fluido caliente que será enfriado posteriormente. Esto permitirá que las moléculas que estén 

desordenadas adquieran mayor energía mediante el aumento de la temperatura, ocasionando la 

transición hacia posiciones de mayor orden, que lleven al patrón inicial cuando se da el 

enfriamiento.  El procedimiento también es conocido como recocido y es necesario determinar la 

temperatura correcta de recristalización para evitar la completa fusión del sistema (Mullin, 2014). 
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I.2 MODELOS UTILIZADOS EN EL ESTUDIO TRANSICIONES VITREAS O 

CRISTALINAS  

 

Desde hace varias décadas, muchos científicos buscan comprender el aumento en los tiempos de 

relajación estructural en un sistema fluido cuando éste se aproxima a la transición vítrea o a un 

estado cristalino, debido a un proceso de enfriamiento controlado (Debenedetti & Stillinger, 2001).  

Todo esto ocurre a nivel molecular donde la observación directa es complicada, por ello el estudio 

de los cambios estructurales y dinámicos de un sistema durante la solidificación, comúnmente se 

realiza a través de experimentos de dispersión de ondas electromagnéticas o neutrones, 

dependiendo de la escala espacial a la que se requiere la observación.  

 

Desde el punto de vista técnico actual, el seguimiento incluso de una sola partícula en un sistema 

formador de vidrio o de un cristal durante su enfriamiento no es posible. La resolución temporal y 

la capacidad de rastreo necesarios implican una alta tecnología aún no desarrollada. Aun así, 

avances recientes donde se utilizan técnicas de interferometría óptica han demostrado que es 

posible rastrear al menos una partícula Browniana confinada (Pusey P. N., 2011). Sin embargo, 

analizar con el mismo detalle el comportamiento colectivo de partículas Brownianas es un desafío 

y más lo es examinar sistemas moleculares. Para estudiar con mayor profundidad la fenomenología 

que ocurre a nivel molecular, se han utilizado algunos modelos macroscópicos provenientes de 

diferentes sistemas tales como mezclas de coloides poliméricos, emulsiones, espumas, y sistemas 

granulares. Estos sistemas exhiben una fase amorfa o cristalina cuando se varía una cantidad física 

como la fracción de volumen, la temperatura, la concentración, etc.  

 

Los sistemas coloidales son usados para comprender los mecanismos implícitos en las transiciones 

vítrea y cristalina, desde un gas o líquido. Actualmente, se han realizado importantes avances, como 

la implementación del microscopio láser confocal de alta velocidad que permite la obtención de 

secuencias de imágenes en tres dimensiones (Anderson & Lekkerkerker, 2002). Estos sistemas se 

han empleado como modelos de materiales atómicos debido a que son más grandes que las 

moléculas y su desplazamiento es más lento, lo que hace posible su observación directa. Además, 

poseen un comportamiento similar de fases y contracción de volumen durante el enfriamiento 

(Pusey, Van Megen, Underwood, Bartlett, & Ottewill, 1991).  
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En particular, se ha demostrado que un sistema ideal para estudiar estos fenómenos es la suspensión 

coloidal de partículas magnéticas, estos sistemas exhiben características dinámicas y estructurales 

de formadores de vidrio y de cristales (König, 2005). 

 

Los sistemas microfluidicos se han usado para describir los fenómenos presentes en la nucleación 

que consecuentemente lleva a la cristalización de partículas pequeñas y de proteínas. Para este fin 

se utilizan emulsiones de aceite en agua que pueden asumir distintas formas, la más común es la 

esférica. El procedimiento consiste en hacer pasar gotas del fluido emulsionante en un dispositivo 

diseñado para tal efecto, a medida que este fluye se da una reducción de temperatura que induce a 

la cristalización. La experimentación arroja imágenes que son analizadas mediante técnicas ópticas, 

que derivan en la obtención de información sobre la cinética del proceso (T. A. & E. M. , 2016). 

 

 Los sistemas granulares bajo vibraciones mecánicas también han sido estudiados como modelos 

de transición vítrea o cristalina. Su dinámica puede ser estudiada fácilmente debido a que son 

partículas macroscópicas y sus movimientos son lo suficientemente lentos como para ser 

evaluados. La agitación del sistema es inducida por medio del contenedor, que oscila a cierta 

frecuencia, esto permite ejercer un control sobre la interrelación individual y grupal de los gránulos. 

En un trabajo reciente se presentó un modelo granular sin vibración para un líquido a base de 

pequeños balines magnéticos bajo un campo magnético alterno. Se demostró que las partículas 

tienen movimiento Browniano ya que describen un movimiento aleatorio en la superficie y que la 

distribución de velocidades sigue una distribución de Maxwell-Boltzmann que puede ser 

controlada por la amplitud del campo magnético aplicado, de donde es posible la obtención de la 

temperatura efectiva. El modelo usado es un sistema granular no-vibrante donde las partículas se 

mueven al azar como moléculas en un líquido, variando el campo magnético, la temperatura 

efectiva puede ser modulada. Es decir, la energía cinética promedio de las partículas depende de la 

intensidad del campo magnético. La entrada continua de energía evita que las partículas se 

detengan y no es necesario usar vibraciones mecánicas. Al inicio las partículas se difunden en toda 

el área fluyendo como las moléculas en un líquido, pero cuando se enfría, el sistema se convierte 

en un vidrio y su envejecimiento puede ser observado (Tapia-Ignacio, Garcia-Serrano, & Donado, 

2016). 
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I.3 MAGNITUDES ESTRUCTURALES Y DINÁMICAS PARA LA 

DESCRIPCIÓN DE SISTEMAS FORMADORES DE VIDRIOS Y CRISTALES   

 

Para determinar las características estructurales y dinámicas del sistema, se pueden utilizar las 

mismas herramientas usadas en estudios de simulaciones numéricas de líquidos formadores de 

vidrios o de cristales. Entre ellas se encuentra la función radial de distribución, el desplazamiento 

cuadrático medio, la función de dispersión intermedia y los potenciales efectivos. También pueden 

usarse los polígonos de Voronoi los cuales se construyen sobre la base de los vecinos más cercanos, 

obteniéndose información del área efectiva donde las partículas se mueven.  

 

I.3.1 FUNCIÓN DE DISTRIBUCIÓN RADIAL  

 

Cuando un gas sufre una transición hacia la fase liquida la distancia entre las partículas se hará 

cada vez más estrecha conservándose un comportamiento difusivo, pero en evolución hacia un 

comportamiento de partícula arrestada. Si el sistema logra evolucionar hacia un estado sólido el 

espacio entre ellas será aún más corto obstaculizando el movimiento, esto conduce a la formación 

de estructuras amorfas si se trata de vidrios, o periódicas y ordenadas si se consigue la 

cristalización. 

 

La función radial de distribución g(r), describe la probabilidad de encontrar partículas en la 

posición r desde una partícula tomada como referencia. Se considera que esta cantidad describe la 

estructura de sistemas microscópicos a niveles reales, permitiendo discriminar entre distintas fases 

y es definida como 

 

𝒈(|𝐫|) =
𝑝2(|𝐫|)

𝜌
, 

 

donde 𝝆 . 𝒈(r) corresponde a la densidad de partículas a cierta distancia r de una partícula a la que 

se tomó como referencia y 𝜌 es la densidad de partículas en el bulto. El superíndice ”2” indica que 

solo se consideran las relaciones a pares (Haro Pérez , Reyes Contreras , & Mayorga Rojas , 2018).  
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El siguiente esquema (fig. 1.2) exhibe la estructura de un fluido simple y su respectivo gráfico de 

g(r), las partículas se encuentran distribuidas alrededor de la que se tomó como referencia. Se 

observa un patrón característico de un ordenamiento de corto alcance evidenciado por la marcada 

curva inicial. Sin embargo, en las siguientes capas se observa menor orden y provocando que los 

pozos de g(r) se desvanezcan. Esto sucede porque la probabilidad de encontrar partículas va 

disminuyendo mientras aumenta la distancia, debido al desorden de las partículas.  

 

 

Figura 1.2: Estructura microscópica y esquema de g(r) para un fluido simple. Extraída del artículo Introduction to 

modern statistical mechanics. Chandler D. 2018. University of California, Berkeley,1987. 

 

La g(r) es una función relevante para la determinación de estructuras atómicas durante el proceso 

de solidificación. Esta puede ser calculada por medio de procedimientos experimentales y 

programas computacionales, y es importante porque facilita la conexión entre modelos propuestos 

y los experimentos. 

   

I.3.2 POLÍGONOS DE VORONOI  

 

Un polígono es una región planar limitada por segmentos que en su conjunto forman una curva 

cerrada simple. Los polígonos de Voronoi pueden ser definidos como los poliedros más pequeños 

formados por la bisección perpendicular entre los puntos centrales de una partícula tomada como 

referencia y las vecinas más próximas (Tapia-Ignacio, Moctezuma, & Donado, 2018). Al patrón 

completo formado por el conjunto de polígonos se le conoce como teselación de Voronoi.  

Ubicación más 

probable de la 

primera capa de 

coordinación. 

Primera capa de 

coordinación. 
Segunda capa de 

coordinación. 

Ubicación más  

probable de la  

segunda capa de 

coordinación. 
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Esta herramienta se ha utilizado exitosamente en distintas disciplinas como la geografía, 

arqueología, ecología, geología y meteorología, por mencionar algunas. Así como en el análisis 

estructural de diferentes sistemas modeladores de vidrios y cristales. 

 

Los diagramas resultantes ofrecen información sobre la organización de las partículas contiguas 

(figura 1.3). Cuando no hay un orden aparente la geometría es irregular, pero se vuelve regular al 

equilibrarse el sistema en su estado de mínima energía. Si el área de los poliedros comienza a ser 

uniforme significa que ha iniciado la transición cristalina (Kumar, V. S & Kumaran, V., 2005).    

 

 

Figura 1.3: Teselación Voronoi de una configuración de esferas duras, con condiciones de contorno periódicas.  

Obtenida de Voronoi neighbor statistics of hard-disks and hard-spheres. Kumar, V. S., & Kumaran, V. The Journal 

of Chemical Physics, 2005. 

 

De esta manera la teselación de Voronoi permite seguir la evolución del sistema hacia transiciones 

vítreas o cristalinas, ya que la regularidad aumentará conforme se consiga la solidificación, 

permitiendo definir la fase presente a lo largo del procesamiento y por supuesto la fase final.    

 

I.3.3 MOVIMIENTO BROWNIANO  

 

El movimiento Browniano ha sido analizado desde hace varias décadas, comenzando por el escocés 

Robert Brown de quien deriva el nombre. Brown observó pequeñas partículas de polen suspendidas 

en un líquido las cuales se desplazaban de manera irregular y sin motivo aparente. Posteriormente 

este tipo de movimiento fue estudiado más profundamente y observado en distintas disciplinas, 

como matemáticas, física, estadística, geografía, microbiología, etc.  
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Su estudio ofrece importante información sobre fenómenos de transporte.  Este tipo de movimiento 

es aleatorio y se da de manera continua debido a las colisiones que ocurren entre la partícula 

Browniana y las partículas circundantes en el medio fluido. La siguiente imagen ilustra el 

movimiento Browniano de una partícula y su trayectoria, en una de sus coordenadas obtenidas a 

través de un ordenador, en ella se puede ver un comportamiento errático y difusivo (Rincón, 2012). 

 

  

Figura 1.4: Movimiento Browniano y la trayectoria seguida sobre una de sus coordenadas (generada en 

computadora). Extraida de Introducción a los procesos estocásticos, Facultad de Ciencias UNAM. 

 

Debido a la escala a la que se presenta el fenómeno, los estudios se han realizado mediante técnicas 

de dispersión de luz y de imágenes ópticas. Es posible seguir las trayectorias descritas por las 

partículas a intervalos de tiempos, aunque no con la resolución suficiente para observar un 

movimiento continuo. Para el análisis de este movimiento se ha empleado el desplazamiento 

cuadrático medio como una medida de difusión (Donado, Moctezuma, López-Flores, Medina-

Noyola, & Arauz-Lara, 2017).  

  

I.3.4 DESPLAZAMIENTO CUADRÁTICO MEDIO  

 

El desplazamiento cuadrático medio (DCM) es una propiedad dinámica ampliamente utilizada para 

medir experimentalmente la difusión de partículas con movimiento aleatorio en un determinado 

tiempo, está definido de la siguiente manera:  

 

𝐷𝐶𝑀 (𝑡) =  〈|𝑟(𝑡 + 𝑡0 ) − 𝑟(𝑡0 )|2〉, 

 

donde 𝑡0  es un tiempo inicial y 𝑡 es un tiempo posterior.  
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Esta definición corresponde a el DCM de una sola partícula, por lo que es necesario calcular el de 

todas las partículas del sistema y así obtener un promedio (Onofre Hernández , 2010).  

 

Los resultados dependen de la rapidez con la que se mueven las partículas y de la cantidad de 

choques que sufran las mismas, por lo que también el tiempo transcurrido y la distancia recorrida 

influirán en el análisis. La información obtenida del DCM es muy relevante debido a que se pueden 

determinar las características difusivas del sistema. Si se trata de un medio fluido el valor del DCM 

(t) es alto sin embargo si este fluido se enfría y se acerca al estado sólido, los valores del DCM 

disminuirán conforme se enfríe el sistema (Carrasco Fadanelli & Huerta Hernández, 2012). 
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CAPÍTULO II 

 

CRISTALIZACIÓN MEDIANTE UN SISTEMA DE MATERIA 

GRANULAR NO VIBRADA 

 

 

II.1 INTRODUCCIÓN  

 

Cuando un sistema fluido se enfría por debajo de la temperatura de solidificación, se consigue un 

cuerpo sólido, el cuál puede ser un vidrio si el enfriamiento es rápido o un cristal si la temperatura 

se reduce lentamente y existen las condiciones necesarias para conseguir un ordenamiento de largo 

alcance. 

 

Actualmente el estudio del proceso de la cristalización se ha realizado de manera indirecta con 

técnicas de interferometría óptica y radiación electromagnética, ya que la resolución temporal y 

espacial necesaria para el análisis a nivel molecular durante el proceso, implica el uso de tecnología 

muy avanzada. Por ello, se han propuesto distintos modelos macroscópicos que presentan 

características análogas a sistemas fluidos reales, entre estos sistemas encontramos: suspensiones 

coloidales, espumas, emulsiones y sistemas granulares vibratorios, los cuales han resultado ser 

buenos modelos de fluidos formadores de vidrio y cristales.  

 

El modelo propuesto se basa en el uso de pequeñas partículas de acero suspendidas en una 

superficie cóncava que induce a la cristalización. La temperatura es controlada por medio de un 

campo magnético sinusoidal dependiente del tiempo. De esta manera se usan distintas rapideces de 

enfriamiento que permiten la obtención de diferentes estructuras. 
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II.2 CONFIGURACIÓN EXPERIMENTAL   

 

El sistema granular estudiado consiste en 130 partículas de acero inoxidable ANSI 420 grado 1000, 

de 1 mm de diámetro confinadas en una superficie cóncava circular de 50 mm de diámetro que 

genera un campo gravitacional radial que induce la agregación, dicha superficie es una lente con 

una distancia focal de 250 mm. El sistema se sitúa horizontalmente en medio de un par de bobinas 

de Helmholtz de 150 mm de diámetro que producen un campo magnético homogéneo 

perpendicular al contenedor de las partículas. 

 

Las bobinas son alimentadas por medio de un amplificador de potencia Kepco controlado por una 

señal generada por una PC a través de una tarjeta de adquisición de datos National Instruments. La 

forma general del campo magnético B aplicado al sistema es: 

 

 

 

Bc = campo magnético estático y toma valores de 0 G a 120 G 

Bo = amplitud del campo magnético, con valores de 30 G a 120 G. 

f = frecuencia de la parte senoidal del campo magnético, se mantiene a 9.25 Hz.  

 

En los ensayos, las partículas se someten a un campo magnético sinusoidal todo el tiempo. Los 

experimentos se llevan a cabo después de que el campo magnético se activa durante 30 minutos a 

120 G, después de este período no se esperan más cambios en el comportamiento del sistema, al 

menos no durante el tiempo que dura cada experimento.  

 

En este caso, el componente variable del campo magnético aleatoriza los movimientos de las 

partículas, las partículas ruedan aleatoriamente sobre la superficie de observación de acuerdo con 

la amplitud del campo aplicado, lo que produce que el movimiento de las partículas sea análogo al 

movimiento Browniano. En cuanto la intensidad del campo disminuye la dinámica también lo hace, 

cesando por completo en algún momento. El esquema de la configuración experimental se muestra 

en la siguiente imagen (ver figura 2.1). 

 

B = Bc + Bo sin (2 π f t) 
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Figura 2.1: Esquema de configuración experimental utilizado durante los ensayos. 

 

Mientras las partículas ruedan, la energía magnética se transforma en energía cinética. Al mismo 

tiempo parte de esta energía se pierde debido a la fricción con la superficie del contenedor y debido 

a colisiones con otras partículas. Esta pérdida de energía es compensada por la continua entrada de 

energía que proviene del campo magnético variable, esto evita que los movimientos de las 

partículas se detengan. Por lo tanto, el sistema no está en equilibrio termodinámico, pero si alcanza 

un estado estacionario. En el punto más bajo de intensidad del campo magnético, las partículas 

quedan estáticas concentradas en el centro de la superficie. A diferencia de trabajos anteriores 

(Tapia-Ignacio, Garcia-Serrano, & Donado, 2016), en éste se usa una superficie cóncava que hace 

que las partículas experimenten una interacción hacia el punto central lo cual modela atracción 

entre ellas, a diferencia de una superficie plana donde las interacciones son solamente repulsivas.    

 

Los experimentos en este sistema a diferentes condiciones de enfriamiento son grabados utilizando 

una videocámara Sony HandyCam. Posteriormente, los videos son descomprimidos y analizados 

para obtener información sobre la evolución del proceso de cristalización en función de los distintos 

tiempos de enfriamiento. Los archivos de vídeo se toman a una rapidez de captura de 30 cuadros 

por segundo en formato AVI entrelazado. Posteriormente, las capturas son descomprimidas y se 

aplica un filtro para separar las imágenes en pares e impares obteniendo un aumento en la 

resolución, quedando finalmente en 1/60.  
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El procedimiento empleado en los experimentos se detalla a continuación: 

 

-El equipo es encendido en este orden: PC, lámpara, cámara, tarjeta de adquisición de datos y fuente 

amplificadora.   

-El software de enfriamiento y el de captura de videos (Labview 2011) deben ser activados. 

-La superficie en la que estarán contenidas las partículas debe ser nivelada y la cámara alineada 

para garantizar una buena resolución del video.  

-Las partículas tendrán que ser magnetizadas durante 30 minutos, bajo un campo magnético 

constante, sin enfriamiento (120 G). 

-Una vez magnetizadas las partículas, los parámetros de enfriamiento (campo magnético estático, 

amplitud del campo y frecuencia) deben ser ajustados. 

-Las partículas serán distribuidas homogéneamente en la superficie para evitar que se formen 

conglomerados desde el inicio. 

-Cuando se tienen las condiciones óptimas para él experimento de enfriamiento se inicia la 

grabación, una vez que las partículas quedan estáticas se detiene la grabación y se continua con el 

siguiente ensayo. 

-Los videos obtenidos de los experimentos son descomprimidos a través del programa llamado 

VirtualDub del cual se obtienen una resolución de 60 cuadros por segundo gracias a la aplicación 

de su filtro bob doubler.  

-El conjunto de imágenes descomprimidas es analizado a través de ImageJ (que es un software de 

edición de imágenes). Este software permite obtener información sobre la evolución del sistema. 

Las imágenes son sometidas a un proceso de limpieza donde se aplican filtros para obtener solo las 

partículas y eliminar el fondo, al igual que los límites de la celda de observación y sombras 

derivadas de la iluminación. 

En el sistema el componente oscilatorio del campo magnético permite que las partículas se 

desplacen aleatoriamente, mientras que el elemento constante del campo evita que se formen 

cúmulos deformes. El mecanismo fue descrito en trabajos anteriores en donde se utilizó el mismo 

sistema, pero para modelar transiciones vítreas (Tapia-Ignacio, Garcia-Serrano, & Donado, 2016).  
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El siguiente esquema (fig. 2.2) describe el comportamiento dinámico de una partícula con momento 

magnético m en donde el campo aplicado es de tipo vertical sinusoidal y distribuido de manera 

uniforme. Cuando el campo está activo la partícula se alinea con el campo magnético para alcanzar 

una energía potencial mínima (𝛼 = 0). Dado que el campo magnético es sinusoidal, la intensidad 

del campo comienza a disminuir y el campo adquiere la dirección opuesta. En esta condición, la 

energía de la partícula ya no es la mínima, ha cambiado (𝛼 = 𝜋 𝑟𝑎𝑑). Entonces para alcanzar 

nuevamente el mínimo de energía la esfera rueda para alinearse con el campo magnético. La 

dirección de rodamiento es azarosa debido a la forma esférica de la partícula. Después de varios 

ciclos del campo, las partículas pueden desplazarse en toda la superficie.  

 

Aunque la energía se disipa debido a la fricción con el plano y a las colisiones entre las partículas 

mismas, existe una entrada constante de ésta proveniente del campo magnético inestable que evita 

que la dinámica cese. En si el sistema no está en equilibrio termodinámico, pero si alcanza un 

estado estacionario. Debido a que las partículas se encuentran en un plano horizontal, la dirección 

(ϕ) con la que sucede el desplazamiento puede tomar cualquier valor y aquí es donde se origina la 

aleatorización del movimiento.  

 

 

Figura 2.2: Esquema de una esfera con un momento magnético en una región con un campo magnético vertical. 

Extraída del articulo C. Tapia-Ignacio,Nonvibrating granular model for a glass-forming liquid: Equilibration and 

aging, 2016. 

 

 



18 

 

Para determinar los parámetros adecuados que propiciaran la cristalización, se realizó un primer 

ensayo en donde se obtuvieron 9 secuencias de videos a diferentes razones de enfriamiento (RE)1. 

Al inicio del experimento el campo magnético tiene una intensidad de 120 G, se observa una gran 

dinámica de las partículas en la superficie. Sin embargo, al llegar a una intensidad de 30 G la 

dinámica es nula, es aquí donde el experimento ha finalizado. En la tabla 1 se enlistan las distintas 

razones de enfriamiento empleadas y el tiempo total del experimento correspondiente. 

 

Secuencia Razón de enfriamiento. Duración del video. 

1 2 G/s 45 s 

2 1 .4 G/s 65 s 

3 1.0 G/s 90 s 

4 0.6 G/s 150 s 

5 0.2 G/s 450 s 

6 0.14 G/s 643 s 

7 0.1 G/s 900 s 

8 0.06 G/s 1500 s 

9 0.02 G/s 4500 s 
Tabla 1: Razones de enfriamiento empleadas durante el primer ensayo. 

 

Durante la toma de videos se observó que las partículas presentaban un comportamiento 

característico del movimiento Browniano, es decir las partículas se difundían aleatoriamente en la 

superficie, esto debido a la aportación de energía cinética del campo magnético. Realizándose los 

primeros análisis se advirtió que cuando el tiempo de enfriamiento era corto el sistema alcanzaba 

un estado estático rápidamente produciéndose estructuras desordenadas. Sin embargo, al ir 

aumentando el tiempo de enfriamiento se desarrolló un proceso de evolución lento el cual derivó 

en la formación de agregados estables con estructuras ordenadas y periódicas, es decir cristales.  

 

Para corroborar los resultados obtenidos se realiza un segundo ensayo con las mismas razones de 

enfriamiento y la misma concentración de partículas, aunque el tiempo de magnetización empleado 

fue de 20 minutos. Esto condujo a la disminución del rango de la intensidad de campo magnético 

aplicado, ahora finalizando los experimentos a 40 G, ya que en este punto el sistema no mostraba 

más cambios. A continuación, se muestra las razones de enfriamiento y el tiempo empleado (tabla 

2). 

                                                 
1 Razón de enfriamiento: cantidad de Gauss que disminuye la intensidad del campo magnético por segundo. 
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Secuencia Razón de enfriamiento. Duración del video. 

1 2 G/s 40 s 

2 1 .4 G/s 58 s 

3 1.0 G/s 80 s 

4 0.6 G/s 134 s 

5 0.2 G/s 400 s 

6 0.14 G/s 572 s 

7 0.1 G/s 800 s 

8 0.06 G/s 1334 s 

9 0.02 G/s 4000 s 
Tabla 2: Razones de enfriamiento empleadas durante el segundo ensayo. 

 

Así realizando una comparación de las estructuras formadas a una razón de enfriamiento de 0.02 

G/s se observa que en el primer ensayo las partículas forman un arreglo hexagonal compacto en el 

centro de la superficie, pero del lado derecho existe una dislocación. Esto probablemente se originó 

porque algunas partículas se quedaron en una posición donde alcanzaron un estado de energía muy 

bajo en una configuración desordenada, pero no el mínimo que correspondería a una configuración 

ordenada. Esto origino a que otras partículas a lo largo de la dislocación siguieran la misma 

tendencia. En la segunda estructura las partículas describen un comportamiento similar, aunque 

puede observarse arreglo más compacto de tipo hexagonal (ver fig. 2.3).  

 

 

Figura 2.3: Comparación de la estructura final (con una RE de 0.02G/s) del primer y segundo ensayo. 

 

Realizando una comparación de ambos resultados experimentales, se observa que el 

comportamiento general de las partículas fue el mismo. A temperaturas altas las partículas se 

difundían aleatoriamente en toda la superficie, mientras se daba el enfriamiento estas disminuían 

su dinámica, hasta quedar completamente estáticas. Así también, la regularidad estructural fue en 

aumento al prolongar los tiempos de enfriamiento. Esto fue confirmado por la transformada de 

Fourier en donde se obtuvieron los esquemas característicos de transiciones cristalinas (fig.2.4).  



20 

 

Para obtener las imágenes de la transformada de Fourier se utilizan las imágenes correspondientes 

a las estructuras finales, las cuales fueron procesadas utilizando el software ImageJ en donde se 

hizo una selección del área a utilizar y se cortaron los bordes de exterior con la herramienta Crop 

del menú Edit. Finalmente en la barra Process se eligió la opción FFT (transformada rápida de 

Fourier), produciéndose los esquemas mostrados en la siguiente imagen.  

 

 

Figura 2.4: Evolución del experimento a diferentes razones de enfriamiento (RE), con su respectivo patrón de 

Transformada Fourier. 
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II. 3 ANÁLISIS DE DIÁMETRO EFECTIVO A PARTIR DEL USO DE 

VARIANZA 

 

Así también se determinó el diámetro efectivo que fue definido a partir de las estructuras formadas 

por las partículas a diferentes rapideces de enfriamiento. Para ello se emplean las coordenadas de 

las partículas, con ellas se realiza el análisis de varianza2 en X y en Y de cada una de las series 

experimentales. El cálculo se realizó con el Plugin Moment Calculator (perteneciente al software 

ImageJ), posteriormente se obtuvo 4𝜎 que es equivalente al diámetro efectivo de la estructura, 

deducido a través de la raíz de la suma de los datos en X y Y multiplicado por 4.  

 

El siguiente gráfico (figura 2.5) muestra la disminución del diámetro estructural. Mientras el 

sistema está en un estado fluido, hay cambios en el diámetro efectivo por el movimiento irregular 

que describen las partículas. En la etapa final cuando el sistema es sólido (debido al enfriamiento), 

ya no hay cambios. Se observa que el diámetro total final depende de la rapidez de enfriamiento, 

mientras más lento el enfriamiento este es más pequeño. El límite inferior del diámetro es cuando 

las partículas forman un arreglo cristalino hexagonal compacto.  

 

                           (a)                                                                      (b) 

    

Figura 2.5: (a) Evolución del diámetro efectivo a diferentes rapideces de enfriamiento, (b) diámetro estructural 

analizado en la etapa inicial, intermedia y final del experimento. 

                                                 
2 El análisis de varianza es un método estadístico para comparar dos o más medidas obtenidas a partir de datos 

experimentales (Santana Robles , 2007). 
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II.4 POLÍGONOS DE VORONOI  

 

Los polígonos de Voronoi también llamados diagramas de Voronoi son formaciones geométricas 

que proveen información acerca de los vecinos más cercanos, que en el caso del modelo presentado 

definen el área que ocupan las estructuras formadas a partir de las diferentes rapideces de 

enfriamiento experimentadas. Esto permite diferenciar entre las distintas fases pertenecientes a 

un gas, líquido, vidrio o cristal. Asimismo, se puede seguir la evolución estructural del sistema 

a través del tiempo. Se determinaron inicialmente los polígonos de Voronoi extrayendo 100 

imágenes de cada una de las secuencias de los videos resultantes del experimento.  

 

-El procedimiento inicia con la limpieza de las imágenes a través de ImageJ, para ello se abre la 

secuencia de cuadros a analizar a través del menú File>Import>Image secuence, con la herramienta 

*Oval* se elige la sección a examinar excluyéndose los bordes del exterior, se creará una máscara 

seleccionando Edit>Selection>Create mask después seleccionar Process>Image calculator donde 

se revelan las imágenes sin márgenes externos, nuevamente en el menú Process se elige Binary > 

Make Binary en este punto el fondo es completamente blanco y las partículas se muestran como 

puntos negros.  

 

-Para obtener los diagramas de Voronoi seleccionar Process>Binary se da click en la opción 

Voronoi que se encarga de realizar todo el proceso necesario para originar los diagramas, aquí las 

secuencias de imágenes aparecen con excedente de brillo así que para ajustarlo se acude al menú 

Image>Adjust>Threshold en donde se moverán las barras hasta obtener el fondo negro y los 

polígonos en color blanco. 

 

-La información calculada en cuanto a las propiedades de los poliedros se obtiene yendo 

Analyze>Analyze Particles, se indica el tamaño de partícula y la circularidad; en Show seleccionar 

Masks. Marcar las casillas Display results, Clear results, Summarize y Exclude on edges, y pulsar 

OK. Aquí aparece una base de datos con todas las mediciones realizadas por cada cuadro de la 

secuencia analizada. Toda esta información permitirá obtener las gráficas correspondientes sobre 

el área de los polígonos. 
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En la figura 2.5 (a) se muestra el análisis de la progresión del área de Voronoi, proveniente de las 

9 secuencias de videos, en donde se graficó el área de los polígonos contra la amplitud del campo. 

En contraste se colocó un esquema del lado derecho (fig. 2.5 b) con la superposición de los 

polígonos de Voronoi sobre las partículas, con la finalidad de analizar la evolución estructural del 

sistema por medio de la forma de los poliedros de Voronoi a tres temperaturas distintas durante el 

enfriamiento. 

 

                      (a)                                                                                 (b) 

    

Figura 2.5: (a) Disminución de área de los polígonos de Voronoi a diferentes razones de enfriamiento (b) 

superposición de estructuras y polígonos resultantes de la etapa inicial, intermedia y final del ensayo, a una razón de 

enfriamiento de 0.02 G/s.  

   

Como se aprecia en el esquema anterior, para tiempos rápidos de enfriamiento la distribución de 

las áreas de los polígonos de Voronoi abarca una amplia gama de valores, esto significa que los 

polígonos son irregulares y que el área ocupada por las partículas es mayor. A medida que se 

prolonga el tiempo de enfriamiento, los polígonos son más pequeños y la distribución se hace más 

estrecha, indicando la presencia de homogeneidad. No obstante, la tendencia general no es muy 

clara.  

 

Para obtener información más precisa sobre el progreso estructural del sistema por medio de la 

teselación de Voronoi, se hizo un análisis de datos promedios obtenidos a partir de ventanas 

temporales de 100 imágenes (cada una) de todos los enfriamientos, las cuales se tomaron a 10 

temperaturas diferentes es decir a 10 intensidades del campo magnético. El procedimiento fue el 

mismo que el anterior, pero en este caso fue para cada una de las ventanas temporales. 

40 50 60 70 80 90 100 110 120

20000

30000

40000

50000

60000

70000  2 G/s

 1.4 G/s

 1 G/s

 0.6 G/s

 0.2 G/s

 0.14 G/s

 0.1 G/s

 0.06 G/s

 0.02 G/s

Á
re

a
 t
o

ta
l d

e
 p

o
líg

o
n
o

s 
d
e

 V
o
ro

n
o
i 

Amplitud del campo (G)



24 

 

La figura 2.6 del arreglo inicial y final de las partículas, muestra polígonos irregulares y de mayor 

tamaño al comienzo del experimento y para el enfriamiento más rápido. Sin embargo, mientras que 

la razón de enfriamiento era menor y la dinámica de las partículas disminuía, los poliedros 

presentaron una reducción de área y mayor uniformidad morfológica.  

 

 

  Fig. 2.6: Polígonos de Voronoi a diferentes razones de enfriamiento (RE), al inicio y final del enfriamiento. 
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La figura 2.7 (a, b y c) referida a las etapa inicial, intermedia y final muestra la distribución del 

área libre de Voronoi definida por la relación 𝑉𝐴 − 𝑉𝐴ℎ𝑒𝑥   (área de los polígonos de Voronoi menos 

el área hexagonal de los mismos), en donde la frecuencia fue normalizada a la unidad. Se puede 

observar que cuando el sistema está sobre la temperatura más alta los polígonos exhiben un amplio 

rango de valores, en cambio, si la temperatura disminuye el área se hace más uniforme es decir la 

distribución se estrecha.  

 

La posición del pico principal se inclina hacia valores más altos en el eje de frecuencia a medida 

que se da una disminución de temperatura, alcanzándose valores de 2.21 con RE-2 G/s en el 

enfriamiento más rápido, una frecuencia de 3.66 con RE-0.2 G/s en los tiempos intermedios y 4.37 

con RE-0.02 G/s durante el enfriamiento más prolongado. Según este procedimiento, se puede 

observar una tendencia general clara donde a mayor tiempo de enfriamiento el orden de las 

partículas es más evidente. Para el caso del enfriamiento más lento (0.02 G/s) se logró una 

estructura hexagonal compacta propia de un cristal.  

 

Finalmente se realizó una comparación del área final de los diagramas de Voronoi correspondientes 

a las 9 razones de enfriamiento y se llegó una importante conclusión, a medida que el tiempo de 

enfriamiento se prolongaba la intensidad de los picos era mayor, es decir los poliedros presentaban 

homogeneidad. Esto significa que el sistema ha cristalizado (figura 2.7 d). 

 

(a)                                                                                 (b) 
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(c)                                                                          (d) 

    

Figura 2.7: Histogramas del área de polígonos de Voronoi para tres razones de enfriamiento (RE), (a) RE-2 G/s. (b) 

RE-0.2. y (c) RE-0.02 G/s; cada línea pertenece a una específica intensidad del campo magnético. (d) Comparación 

de área final de diagramas de Voronoi con distintas RE. 

 

En estudios anteriores  de este tipo se encontró que la distribución del área libre individual de 

Voronoi estaba muy bien ajustada por la distribución gamma de dos parámetros                             

𝑓(𝑥) =  
𝛽−∝

𝜏(∝)
 𝑥∝−1 𝑒

−
𝑥

𝛽 que es una distribución de probabilidad continúa adecuada para modelar el 

comportamiento de variables aleatorias en el que está involucrado el tiempo, donde ∝ es el llamado 

factor de regularidad el cuál es usado como una medida del parámetro de orden estructural. Se 

espera que este parámetro aumente significativamente en función de la disminución de la 

temperatura, indicando mayor regularidad en el sistema (Moctezuma, Arauz-Lara, & Donado, 

2018). 

 

Para realizar el ajuste de la función gama se utilizó OriginPro8 que es un software de creación de 

gráficos y análisis estadístico de datos, ampliamente utilizado en estudios científicos. En este caso 

se utilizaron las gráficas del área de los polígonos de Voronoi, sobre las curvas obtenidas se realizó 

el ajuste. Se eligió el menú Analysis>Fitting>No Lineal Fitting, se introdujo la fórmula de la 

distribución y se aplicó. El siguiente gráfico (fig. 2.8) ejemplifica el proceso de ajuste en las curvas 

del área de los diagramas de Voronoi, la línea roja corresponde a la distribución gamma, que deriva 

en un acoplamiento muy cercano a la curvilínea original. En el recuadro se expone la ecuación de 

la distribución, y aparecen los valores deducidos a partir de esta, de los cuales se empleará el 

denotado con la letra “A” que corresponde al factor de regularidad. 
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Fig. 2.8: Ajuste de distribución gamma, sobre el área de los polígonos de Voronoi del comienzo del experimento con 

una razón de enfriamiento de 0.02 G/s. 

 

De la implementación de la función gamma se obtuvo ∝ (factor de regularidad) que fue graficado 

contra la amplitud del campo magnético. Según los datos obtenidos, el sistema describe un 

comportamiento distinto al pronosticado, al inicio del experimento (120 G) los valores son muy 

similares entre sí, pero al ir disminuyendo el campo magnético el factor de regularidad también 

disminuyó. Esta tendencia se observa (figura 2.9) entre el enfriamiento más rápido 2 G/s con un 

valor de 3,64 y el más lento de 0.02 G/s con un valor de -0.46. Aunque no se consigue un aumento 

del factor de regularidad con la disminución de temperatura como se esperaba, si se observan 

cambios que podrían indicar una transición. 

 

 

Figura 2.9: Factor de regularidad (ajuste de distribución gamma) a diferentes rapideces de enfriamiento. 
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II.5 DESPLAZAMIENTO CUADRÁTICO MEDIO  

 

El desplazamiento cuadrático medio (DCM) es una de las magnitudes más utilizadas para 

determinar el comportamiento difusivo de las partículas con movimiento Browniano. De esta 

cantidad es posible obtener el coeficiente de difusión, a través de un cuarto de la pendiente del 

DCM que es calculado a partir de las trayectorias que describen las partículas. 

 

Las trayectorias fueron obtenidas con el software ImageJ, el procedimiento es el siguiente:  

 

-Se abre el programa y se elige la secuencia de imágenes a analizar, para después realizar la 

limpieza que excluye los bordes exteriores, este proceso se ha detallado en el apartado anterior. 

 

-Posteriormente elegir el menú Analyze>Analyze Particles colocando el tamaño de píxel cuadrado 

(de 0-100 en este caso) para descartar todos los demás, en este mismo recuadro hacer click sobre 

las casillas Display Results, Clear Results, Summarize, Add to Manager y Exclude on Edges y por 

último pulsar Ok, aparece un panel denominado Process Stack donde pregunta si se quiere realizar 

el análisis en toda la secuencia, dar una respuesta afirmativa. Se obtendrán dos tablas, la primera 

con información de cada una de las partículas sobre área, perímetro, ángulo y posición de estas en 

X y Y, y la segunda contiene todas estas propiedades, pero resumidas por cada cuadro. 

 

-En el menú Plugins elegir Mosaic>Particle Tracker 2D/3D, en la siguiente ventana que dice Data 

dimensión dar que no, aparecerá un nuevo recuadro donde se colocan los parámetros necesarios 

sobre las casillas Radius (6), Cuttof (0), Per/Abs (0.1), LinkRange (1), Displacement (20), se marca 

Absolute y pulsar sobre Preview detected, aquí las partículas aparecen remarcadas en color rojo y 

proporciona la cantidad de estas, después dar click en Ok.  

 

-Al terminar el análisis aparece otro recuadro en donde se selecciona All Trajectories to Table que 

arroja todos los datos sobre las coordenadas de las trayectorias, para visualizar las trayectorias 

hacer click sobre Visualize All Trajectories, en este punto ya se han obtenido todas las posiciones 

de las partículas y el proceso ha terminado. 
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En el siguiente esquema se pueden observar las trayectorias obtenidas después del análisis. Cuando 

el sistema alcanza la mayor temperatura (fig. 2.10 A) se puede apreciar varias líneas que describen 

la difusión de las partículas en la superficie. Sin embargo, cuando se llega a la temperatura más 

baja, la cinética queda suspendida observándose pequeñas líneas y puntos (fig. 2.10 B) 

pertenecientes a trayectorias confinadas, lo que indica la formación de un sólido. 

 

 

Figura 2.10: Trayectorias descritas por las partículas al inicio y final del enfriamiento (RE-2 G/s).  

 

A partir de las coordenadas obtenidas de las trayectorias descritas por las partículas, fue posible 

calcular el desplazamiento cuadrático medio (figura 2.11), del cual se espera que a altas 

temperaturas se obtenga un alto coeficiente de difusión y que al bajar la temperatura exista una 

disminución de este.  

 

El DCM fue calculado por medio de Code::Blocks que es un entorno de desarrollo integrado de 

código abierto para realizar una variedad de programas los cuales pueden ser enlazados con 

distintos compiladores.  

 

El programa compilado funciona de la siguiente manera:  

 

-Lee cada una de las filas de las coordenadas. 

-Calcula el número de trayectorias de cada una de las imágenes y el total de estas por todas las 

secuencias. 
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-Determina los desplazamientos a diferentes lapsos de tiempo, los eleva al cuadrado y suma todas 

estas. 

-Posteriormente obtiene el promedio de todas ellas, que es en si el desplazamiento cuadrado medio.  

 

(a)                                                                               (b) 

    

Figura 2.11: Desplazamiento cuadrático medio al inicio (a) y final (b) del enfriamiento, con una RE de 2 G/s. 

 

La figura 2.12 muestra el comportamiento de las curvas W (t) (coeficiente de difusión) contra el 

tiempo (s), a distintas temperaturas de enfriamiento, que fue calculado con la pendiente del 

desplazamiento cuadrático medio divido entre 4. Cada curva corresponde a las 10 ventanas 

temporales tomadas de las secuencias de imágenes. Se observó que a medida que la temperatura 

disminuye, los valores W (t) disminuyen. Así mismo, durante la solidificación se observa una 

disminución de las curvas W (t) con el tiempo, lo que indica que las partículas han adquirido un 

estado estacionario.  

 

Figura 2.12: Coeficiente de difusión a distintas rapideces de enfriamiento.  
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De lo anterior se deduce que la transición de un alta a baja temperatura produce un cambio de un 

estado altamente difusivo a uno arrestado, donde las partículas consiguen un estado confinado que, 

dependiendo de la velocidad de enfriamiento, es posible la formación de una estructura 

desordenada o cristalina. Cabe mencionar que un proceso de agregación desordenada o cristalina 

ocurre también cuando se tienen partículas disueltas en un líquido que al evaporarse produce 

cambios similares a la disminución de temperatura. 
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II.6 DISTRIBUCIÓN RADIAL 

 

La función de distribución radial g(r), en el sistema propuesto describe la probabilidad de encontrar 

partículas entre la distancia r + dr, desde una tomada como referencia (figura 2.13). Para tal efecto 

se crea un número determinado de circunferencias concéntricas y se calcula el número de partículas 

existentes en dr, para finalmente obtenerse la media. De esta manera se podrá realizar una 

caracterización estructural. 

 

 

Figura 2.13: Distribución radial g(r), las esferas en color naranja se encuentran sobre la distancia r + dr, la rosa es la 

utilizada como referencia.  

 

Así para estudiar el sistema a partir de la distribución radial se utilizó ImageJ iniciando con la 

limpieza de las imágenes para dejar libres a las partículas, posteriormente se selecciona 

rectangularmente la sección a analizar. Mediante la herramienta Crop del menú Edit se recorta la 

parte a analizar, una vez realizado esto ir al menú Plugins>Radial Distribution Function 

(previamente debió instalarse ese plugin), cuando se ejecuta todo el proceso se obtiene la g(r).  

 

Los datos obtenidos del proceso son graficados, la figura 2.14 expresa las curvas de g(r) que para 

el sistema muestra la evolución de un medio fluido al inicio del experimento hacia uno solido 

cuando el enfriamiento había concluido. Realizando una comparación de las gráficas de la función 

de distribución radial se observa que a medida que la temperatura se redujo lentamente se consiguió 

una configuración de tipo cristalina. 
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Este fenómeno fue validado por la disposición de las curvas, que para el primer gráfico (2.14 a) 

son poco marcadas con tendencia lineal indicando la presencia de estados desordenados, en la 

segunda figura (2.14 b) se observan pozos un tanto más definidos que demuestran la formación de 

agregados más estables. Pero cuando se llegó al enfriamiento más prolongado (2.14 c) los pozos 

se hicieron más profundos sugiriendo la formación de estructuras bien ordenadas, es decir se 

consiguió la cristalización. La última grafica (2.14 d) es una comparación de los valores de 

distribución radial para las estructuras obtenidas al final del enfriamiento de todas las series del 

experimento, en ella se exhibió la progresión de curvas poco marcadas a pozos más definidos 

confirmando la transición de una estructura amorfa a una cristalina. 

 

 (a)                                                                               (b) 

     
(c)                                                                               (d) 

     
Fig. 2.14: Función de distribución radial g(r) a diferentes rapideces de enfriamiento, (a) 2 G/s, (b) 0.2 G/s y (c).0.02 

G/s, (d) comparación de g(r) al final del enfriamiento de todas las secuencias. 
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CAPÍTULO III 

 

EFECTO DE PERTURBACIONES EXTERNAS EN LA CRISTALIZACIÓN 

 

 

III.1 INTRODUCCIÓN   

 

En el capítulo anterior, se determinaron las propiedades estructurales y dinámicas de un sistema 

granular 2D sometido a un campo magnético sinusoidal externo. Se utilizaron análisis estadísticos, 

como la varianza, polígonos de Voronoi y la función de distribución radial g(r) para caracterizar la 

homogeneidad espacial de las estructuras formadas por las partículas. Así también se estudió la 

dinámica de las partículas mediante el desplazamiento cuadrático medio que da origen al 

coeficiente de difusión, proporcionando información complementaria sobre los cambios ocurridos 

con la disminución o la rapidez de enfriamiento. Todos estos procedimientos fueron explicados a 

detalle en la sección correspondiente y de manera gráfica en el apéndice A. 

 

De los resultados obtenidos se determinó que el sistema era apto para la modelación del proceso 

de cristalización, debido a que las distintas rapideces de enfriamiento empleadas mostraron la 

transición de un arreglo desordenado hacia una estructura de tipo cristalina cuando se disminuía la 

razón de enfriamiento.  

 

Entonces se decidió realizar más ensayos en donde se modificarían las condiciones experimentales 

para determinar los efectos causados sobre la cristalización. En el segundo experimento se empleó 

una superficie con menor curvatura que la utilizada en el primero (capítulo 2), para este caso en 

particular la lente fue de 500 mm (distancia focal) con la finalidad de precisar a qué razón de 

enfriamiento se daría la cristalización. En el tercero se hizo una combinación de partículas de 2 

tamaños (0.7 y 1 mm) para cuantificar la cantidad de las de menor tamaño que obstruían el arreglo 

periódico. En último y cuarto ensayo se implantaron semillas de 7 y 4 partículas para observar si 

estas influían en la velocidad del proceso y en la estructura final. 
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III.2 MODIFICACIÓN DE SUPERFICIE EXPERIMENTAL  

 

Para este experimento se utilizaron 135 partículas de 1 mm las cuales fueron magnetizadas durante 

30 minutos, las series iniciaron con una amplitud de 120 G y finalizaron con 30 G. En cuanto a la 

modificación de la superficie se decidió utilizar una lente de ft 500 mm, con menor curvatura que 

la utilizada en el primer experimento con una distancia focal de 250 mm. Las razones de 

enfriamiento empleadas fueron de 2, 0.2, 0.1 0.02, 0.01 y 0.005 G/s, para efecto de análisis de este 

apartado se utilizaron solo tres: 2 G/s, 0.01 G/s y 0.005 G/s. El objetivo principal fue determinar a 

qué razón de enfriamiento se propiciaba la cristalización. En la observación directa de los videos 

se observó que, para conseguir la formación de agregados, era necesario aumentar el tiempo de 

enfriamiento encontrado durante el primer experimento, el cual fue realmente extenso. 

 

La siguiente imagen muestra la estructura final formada por las partículas, en un tiempo de 

enfriamiento súbito con una duración de 45 s, intermedio (2.5 hrs.) y el más largo grabado durante 

5 horas (fig. 3.1). Cuando la razón de enfriamiento fue de 2 G/s (fig. 3.1 a) las partículas están 

dispersas sobre la superficie sin orden aparente, en el momento en el que la intensidad del campo 

fue de 0.01 G/s (fig. 3.1 b) se logró un arreglo compacto hexagonal en el centro de la superficie, 

pero no en las orillas. Por esta razón se empleó un mayor tiempo de enfriamiento, disminuyendo a 

0.005 Gauss por segundo (fig. 3.1 c).  Las partículas consiguieron cristalizar de manera más 

uniforme, aunque pueden observarse dislocaciones, vacancias y partículas dispersas en el exterior. 

Las secuencias de imágenes se analizaron mediante ventanas temporales de 100 cuadros cada una.  

  

      (a)                                         (b)                                            (c) 

 

Figura 3.1: Estructura al final del enfriamiento formada por las partículas a una RE de 2, 0.01 y 0.005 G/s (lente de ft 

500 mm).  



36 

 

El análisis de las secuencias de imágenes por medio de polígonos de Voronoi determina el grado 

de uniformidad estructural de las partículas, mediante la medición del área de los diagramas y la 

forma de éstos. Cuando los polígonos son irregulares la estructura es desordenada como la de un 

gas o un vidrio, sin embargo, si los poliedros son homogéneos, entonces se trata de una fase 

cristalina  

 

En la siguiente imagen (fig. 3.2) se muestra que el enfriamiento más rápido de 2 G/s consigue 

polígonos irregulares y de mayor tamaño. Mientras que al ir aumentando el tiempo (con la 

disminución de los Gauss por segundo del campo magnético) los polígonos muestran mayor 

uniformidad en el centro de la superficie, de esta manera cuando la razón de enfriamiento fue de 

0.005 G/s los diagramas se hicieron más estrechos y en general se aprecia mayor homogeneidad 

entre ellos. 

 

      (a)                                           (b)                                          (c) 

 
Figura 3.2: Polígonos de Voronoi a 3 diferentes razones de enfriamiento (lente de ft 500mm). 

 

 

Graficando el área de los poliedros contra la frecuencia normalizada se confirmó lo expuesto en 

las imágenes anteriores. Cuando las partículas estaban dispersas en la superficie y en movimiento, 

las curvas demostraron que el área de los polígonos es muy irregular, pero al final del enfriamiento 

se formaron picos con mayor valor en el eje de la frecuencia (RE-2 G/s). Así al llegar a un tiempo 

intermedio (RE-0.01 G/s) se consiguieron valores más altos sobre la frecuencia con respecto al 

tamaño de los diagramas, y los picos desaparecieron debido a la regularidad de la estructura. Pero 

cuando se llegó al enfriamiento más lento (RE-0.005 G/s) se observó que las distribuciones 

muestran curvas más definidas y valores más altos en comparación con las gráficas anteriores, ver 

la figura 3.3.  



37 

 

(a)                                                                           (b) 

                                                                      
                                              (c) 

 
 

Figura 3.3: Área de polígonos de Voronoi contra frecuencia normalizada empleando una razón de enfriamiento 2 (a), 

0.01 (b) y 0.005 (c) G/s (lente de ft 500 mm). 

 

Realizando el ajuste de la distribución gamma de dos parámetros 𝑓(𝑥) =  
𝛽−∝

𝜏(∝)
 𝑥∝−1 𝑒

−
𝑥

𝛽  se 

encontró el valor de ∝, que es el llamado factor de regularidad. Se puede observar una tendencia 

hacia valores menores al aumentar el ordenamiento de la estructura al finalizar el experimento (fig. 

3.4). 

 

Esta característica fue observada en el primer experimento, durante el enfriamiento más rápido los 

valores disminuyen hasta cierto tiempo sin embargo este aumenta con valores similares al inicio.  

Ahora cuando ya se observan conglomerados la predisposición siempre fue la misma, pasar de 

valores altos a más bajos (por debajo del cero). 

0 2 4 6 8 10

0.0

0.2

0.4

0.6

0.8

1.0

1.2

F
-n

or
m

al
iz

ad
a

Área de polígonos

 120 G

 110 G

 100 G

 90 G

 80 G

 70 G

 60 G

 50 G

 40 G

 30 G

0 2 4 6 8 10

0.0

0.4

0.8

1.2

1.6

2.0

F
-n

or
m

al
iz

ad
a

Área de polígonos

 120 G

 110 G

 100 G

 90 G

 80 G

 70 G

 60 G

 50 G

 40 G

 30 G

0 2 4 6 8 10

0.0

0.5

1.0

1.5

2.0

F
-n

or
m

al
iz

ad
a

Área de polígonos

 120 G

 110 G

 100 G

 90 G

 80 G

 70 G

 60 G

 50 G

 40 G

 30 G



38 

 

 
Figura 3.4: Factor de regularidad a 3 diferentes razones de enfriamiento (lente de ft 500 mm).  

 

 

 

Los resultados de la distribución radial (figura 3.5) demostraron la presencia de fases parecidas a 

un gas o líquido al inicio del experimento y de vidrio o cristal cuando este había finalizado. El 

primer esquema denota un arreglo amorfo debido a un enfriamiento súbito (RE-2 G/s). Mientras 

que, cuando se utilizó la razón de enfriamiento de 0.01 G/s las curvas mostraron ser más marcadas 

con pozos profundos que indican la formación de un agregado estable. Ya durante el enfriamiento 

más prolongado (fig. 3.5 c) se obtuvo un gráfico correspondiente a una transición cristalina, aunque 

pueden verse picos un tanto irregulares debido a que el sistema no cristalizo completamente.  
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(c)                                                                               (d) 

    
Figura 3.5: Función de distribución radial g(r) correspondiente a los enfriamientos rápido (2 G/s), intermedio (0.01 

G/s) y el más lento (de 0.005 G/s). (d) Comparación de g(r) de las estructuras finales en tres distintas razones de 

enfriamiento. 

 

 

El último esquema expone las g(r) de las estructuras percibidas al finalizar el experimento (fig. 3.5 

d), en donde se exhibe la transición de un sistema desordenado a uno homogéneo. Así la línea negra 

corresponde al enfriamiento más rápido con una forma propia de un arreglo amorfo, en las 

siguientes se muestran picos más prolongados referidos a una fase ordenada, no obstante, la línea 

perteneciente al enfriamiento más lento posee una curvatura más profunda indicando la presencia 

de una estructura cristalina, con algunas irregularidades debido a que ciertas partículas quedaron 

dispersas en el exterior.  
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III.3 MEZCLA DE PARTÍCULAS DE 2 TAMAÑOS DISTINTOS  

 

Este experimento se realizó con una combinación de partículas de 1 mm y de 0.7 mm con la 

finalidad de determinar, qué cantidad de esferas de menor tamaño obstruirían el arreglo ordenado 

de las mismas, es decir la cristalización. Se emplearon las condiciones experimentales 

convencionales, usando la lente de 250 ft, un delta de enfriamiento de 0.02 G/s que fue constante 

en todos los videos, y se inició con 120 G y finalizó 30 G. En todas las series se utilizaron 80 

partículas de 1 mm y las de 0.7 mm se fueron aumentando hasta llegar a 80, lo que significa que 

en la última serie se empleó un 50% de cada tamaño.  

 

Durante el enfriamiento se observó que las esferas pequeñas eran desplazadas al exterior de la 

superficie, formándose agregados de corto alcance, pero solo con las que compartían las mismas 

características. Al enfriarse el sistema las esferas de menor tamaño fueron agregadas a la estructura, 

aunque estas influyeron en el arreglo, el cual se hizo cada vez más irregular al aumentar la 

concentración de las partículas de 0.7 mm, lo que derivó en la formación distintos defectos como 

dislocaciones y vacancias.  

 

En la siguiente imagen se muestran las estructuras obtenidas al final del enfriamiento (fig. 3.6). 

Cuando se utilizaron solo 5 partículas pequeñas estas no influyeron en el arreglo consiguiéndose 

uno de tipo compacto, dos de ellas fueron incluidas en el centro de la estructura demostrando un 

fenómeno interesante: las de mayor tamaño siguieron su configuración regular hexagonal alrededor 

de la menor. En la siguiente secuencia, la estructura fue menos regular debido a que el aumento de 

esferas de 0.7 mm influyó en el desplazamiento de las de 1 mm originándose dislocaciones y 

vacancias. La irregularidad aumentó cuando se emplearon 20 partículas pequeñas las cuales 

interfirieron en el movimiento de estas impidiendo que se obtuviera un solo agregado con la 

inclusión de todas las esferas. En las secuencias posteriores la dinámica del sistema fue realmente 

afectado por las cuentas de menor tamaño, originándose patrones cada vez más amorfos. Esto fue 

confirmado por los patrones de la transformada de Fourier, incluidos en la imagen en 

correspondencia con cada formación estructural, en dichos esquemas se exhibe una marcada 

transición de un ordenamiento de largo alcance, pasando por uno de corto alcance a una estructura 

totalmente amorfa. 
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Figura 3.6: Estructura final y transformada de Fourier de combinación de partículas de 1mm y 0.7mm. 

 

Las secuencias de imágenes fueron analizadas mediante polígonos de Voronoi los cuales son una 

medida de orden estructural. Así como se muestra en la siguiente figura (fig. 3.7) se avanza de 

polígonos regulares a irregulares. Inicialmente, cuando se agregaron pocas partículas de 0.7 mm 

no se afectó la estructura, pero si cuando aumento la concentración de éstas, se obtuvieron poliedros 

cada vez más irregulares y de mayor tamaño. 

 

 
Figura 3.7: Polígonos de Voronoi de las estructuras al final del enfriamiento, resultantes de la combinación de 

partículas de 1mm y 0.7 mm. 
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La siguiente gráfica (fig. 3.8) corresponde a las estructuras finales del sistema, la frecuencia 

(normalizada a la unidad) indica la cantidad de poliedros con área similar. La cual es muy diferente 

a las obtenidas en experimentos anteriores, ya que en ellas se observaba una tendencia a aumentar 

los valores sobre la frecuencia mientras se prolongaba el tiempo de enfriamiento, sin embargo, en 

este caso en particular se observa algo distinto debido a los dos tamaños empleados. 

 

Inicialmente cuando se tienen pocas partículas de 0.7 mm se observa un solo pico con mayor 

magnitud (línea negra) que va disminuyendo al aumentar la concentración de las de menor tamaño. 

En el momento en el que se llega a un 20% de las partículas más pequeñas se aprecia un pico extra 

del lado izquierdo, aunque con menor frecuencia (color azul). Al ir aumentando la cantidad de las 

esferas pequeñas los picos correspondientes a los diagramas de las esferas de 1mm disminuyen 

desplazándose hacia la derecha mientras que los otros (de las partículas de 0.7 mm) van 

aumentando. Este fenómeno se debe a la presencia de partículas de dos tamaños en la superficie y 

también a la transición de un estado cristalino a uno amorfo, ya que la frecuencia en cuanto a la 

cantidad de polígonos regulares ha disminuido. 

 

 
Figura 3.8:  Histograma del área de los polígonos de Voronoi obtenidos en la etapa final del enfriamiento, 

pertenecientes a la mezcla de partículas de 1mm y 0.7mm. 

 

 

El análisis de distribución radial durante los experimentos en general mostró una evolución de 

estado gaseoso a uno sólido a medida que la temperatura disminuye.  
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Ahora bien, realizando una comparación entre las gráficas de función de distribución radial 

obtenidas a distintas concentraciones de esferas de 0.7 mm (fig. 3.9 a, b, c), se puede observar una 

disminución en la curvatura de las g(r), debido a que estas interfieren en la dinámica de las 

partículas provocando defectos en las estructuras finales. Esto es más evidente en el gráfico final 

(fig. 3.9 d) donde las g(r) (correspondientes a las estructuras al final del enfriamiento) describen la 

progresión de un orden de largo alcance cuando se emplearon 5 y 10 esferas de 0.7 mm, de uno de 

corto alcance al usar 20 partículas de menor tamaño, a uno totalmente irregular a partir de 40, 

donde los picos son menos pronunciados, aunque aún describen la forma correspondiente a una 

estructura sólida.  

 

(a)                                                                               (b) 

         
(c)                                                                               (d) 

     
Figura 3.9: Función de distribución radial g(r), (a) 5 partículas de 0.7 mm, (b) 40 partículas de 0.7 mm, (c) 80 

partículas de 0.7 mm y (d) estructuras de la etapa final del enfriamiento derivada del aumento en la concentración de 

esferas pequeñas. 
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III.4 CRISTALIZACIÓN CON NÚCLEO DE  7 Y 4 PARTÍCULAS 

 

El proceso de cristalización ocurre cuando el enfriamiento es lento y se dan las condiciones 

necesarias para conseguir un arreglo periódico y ordenado. No obstante, algunas técnicas 

implementan la “siembra de embriones” en donde colocan semillas ya cristalizadas, consiguiendo 

que las partículas sigan la estructura inicial y que el proceso se dé más rápida y fácilmente. En el 

sistema se observa que para lograr la cristalización primero debía formarse un agregado de 

partículas en el centro de la superficie, el cual debía ser lo suficientemente estable para soportar las 

colisiones de las partículas circundantes. Entonces se dedujo que si se colocaba un núcleo durante 

el experimento el tiempo de procesamiento podría ser menor. 

 

Para tal efecto se utilizaron 120 partículas de 1 mm magnetizadas durante 30 minutos. Se usó la 

lente de ft 250 mm, empleando 5 diferentes rapideces de enfriamiento, las series iniciaron con 120 

G y finalizaron en 30 Gauss. Para este experimento se realizaron 2 núcleos: uno de 4 y otro de 7 

partículas de igual tamaño. Las semillas se colocaron en el centro del área de observación donde 

se originan los agregados iniciales, durante la toma de los videos se observó que estos sufrieron 

cierto desplazamiento hacia distintas posiciones, debido a los choques entre las partículas por la 

alta interacción entre ellas. Así también, se advirtió que el tiempo de procesamiento fue mucho 

menor que el empleado durante un proceso de cristalización convencional (en el modelo).  

 

En la imagen siguiente (fig. 3.10) se realizó una comparación de las estructuras formadas durante 

los primeros experimentos (capítulo anterior) y las obtenidas con la implantación de los núcleos de 

7 y 4 partículas, con el propósito de observar la evolución del sistema en cuanto a la morfología 

estructural y el tiempo de procesamiento. De manera general se puede ver que la formación de 

conglomerados se da desde el enfriamiento más rápido (2 G/s), observándose un orden de corto 

alcance, cuando se aumentó el tiempo de enfriamiento (0.02 G/s) el empaquetamiento fue 

haciéndose cada vez más uniforme y compacto.  

 

Para el caso de la semilla de 7 partículas se dio un ordenamiento de corto alcance desde la primera 

serie, el arreglo conseguido fue compacto de tipo hexagonal en donde todas las partículas fueron 

agregadas a excepción de una vacancia al exterior. 
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Cuando se utilizó el núcleo de 4 partículas se produjo defectos en el arreglo, originándose 

dislocaciones en ciertos puntos, aunque en las siguientes capas se siguió con el arreglo de tipo 

hexagonal. Así también, se observó una disminución en el tiempo de cristalización con la 

formación de agregados desde el primer enfriamiento. 

 

 
Figura 3.10: Evolución del experimento a diferentes razones de enfriamiento (RE), las estructuras corresponden al 

final del enfriamiento durante el primer experimento y empleando un núcleo (resaltado) de 7 Y 4 partículas. 

 

La imagen siguiente (fig. 3.11) muestra la comparación de los polígonos de Voronoi obtenidos a 

diferentes rapideces de enfriamiento del primer experimento, y con los núcleos de 7 y 4 partículas, 

los espacios vacíos concéntricos corresponden a los embriones implantados. En ella se puede ver, 

que cuando se empleó la semilla los polígonos fueron más regulares en comparación con los del 

experimento convencional, en el caso de la semilla de 7 partículas la regularidad es mayor que para 

el de 4 partículas.  
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En general se observa que durante los enfriamientos rápidos la uniformidad en cuanto a la forma y 

tamaño era muy dispersa, pero al aumentar el tiempo de enfriamiento los poliedros fueron 

reduciendo su área y regulando su morfología. Aunque es evidente que el núcleo de 4 partículas 

modifico un tanto la estructura hexagonal compacta, produciéndose dislocaciones en ciertas 

direcciones, lo que produjo una línea divisoria totalmente recta entre los polígonos.   

 

 
 Figura 3.11: Polígonos de Voronoi a diferentes razones de enfriamiento (RE) del primer experimento, y empleando 

un núcleo de 7 y 4 partículas. 

 

En las gráficas siguientes (fig. 3.12) se compara la frecuencia normalizada contra el área de los 

poliedros, los puntos iniciales demuestran una variación en el tamaño de los diagramas, mientras 

aumenta la rapidez de enfriamiento los valores de los picos son mayores en el eje de la frecuencia 

indicando que el sistema se hace más homogéneo. Así en la gráfica (3.12) la frecuencia es mayor 

que al siguiente esquema (3.13) que corresponde al núcleo de 4 partículas, en ésta se observa un 

ligero desplazamiento de los picos, esto debido a que en las estructuras formadas existen 

dislocaciones. 
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                             (a)                                                                      (b) 

  
Figura 3.12: (a) Histograma del área de los polígonos de Voronoi a diferentes razones de enfriamiento (RE) 

empleando un núcleo de 7 partículas, (b) superposición de los polígonos de Voronoi en las estructuras obtenidas a 

tres temperaturas experimentadas. 

 

                            (a)                                                                       (b) 

  
Figura 3.13: (a) Histograma del área de los polígonos de Voronoi a diferentes razones de enfriamiento (RE) 

empleando un núcleo de 4 partículas, (b) superposición de los polígonos de Voronoi en las estructuras obtenidas a 

tres temperaturas experimentadas. 

 

Los resultados de la g (r) de la estructura al final de los enfriamientos demuestran la evolución de 

una estructura con ordenamiento de corto alcance a un sistema completamente cristalino. En este 

caso las curvas no exhiben mucha variación en su forma debido a que los conglomerados suceden 

más rápidamente con la siembra de los núcleos. Aunque los pozos son más evidentes del lado 

izquierdo en la gráfica 3.14 (a) que en el esquema de 4 partículas ya que en este no se dio la 

cristalización completa. 
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 (a)                                                                            (b) 

   
Figura 3.14: Función de distribución a radial diferentes razones de enfriamiento (RE), empleando un núcleo de 7 (a) 

y 4 (b) partículas. 
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CONCLUSIONES Y PERSPECTIVAS  

 

Se estudió un modelo de cristalización basado en un sistema granular no vibrado, bajo un campo 

magnético sinusoidal vertical, en el cual las partículas describen movimientos aleatorios similares 

a los de las partículas brownianas.  Las propiedades dinámicas y estructurales del sistema pueden 

controlarse mediante la variación de la magnitud del campo magnético (análogo a la temperatura) 

y la superficie donde se colocan las partículas. El campo externo dependiente del tiempo produce 

interacciones atractivas y repulsivas induciendo a un comportamiento complejo que varía 

conforme a la razón de enfriamiento, las partículas ruedan en la superficie en diferentes 

direcciones, sufren colisiones y en algún punto forman grupos de diferentes tamaños. Cuando 

el enfriamiento es rápido se forman pequeños agregados poco estables, pero a medida que se 

aumenta el tiempo, la dinámica del sistema se vuelve más lenta, entonces en estas condiciones 

se puede lograr un solo conglomerado que incluye todas las partículas.  

 

Al realizar los experimentos se observó que, al disminuir la magnitud del campo el sistema produjo 

un proceso de enfriamiento que originó distintos fenómenos. Las estructuras desordenadas fueron 

provocadas por enfriamientos súbitos, pero a medida que el tiempo se prolongó las partículas 

consiguieron arreglase de manera regular. Así que empleando diferentes razones de enfriamiento 

se llegó a la formación de distintas estructuras parecidas a un gas, líquido, vidrio o a un cristal 

(objetivo principal del presente trabajo). Al cambiar las condiciones experimentales se 

pudieron analizar algunas variaciones del proceso de cristalización.  

 

Modificando la curvatura de la superficie experimental por una menor (de 250 mm de distancia 

focal a 500 mm) se llegó a estructuras ordenadas, pero el tiempo de enfriamiento tuvo que 

aumentarse considerablemente, esto fue porque la cristalización se logra al agruparse las 

partículas en el centro del contenedor por su forma cóncava. En otro experimento se emplearon 

partículas de tamaños distintos (1 y 0.7 mm) a una razón de enfriamiento de 0.02 G/s, la 

concentración de las de menor tamaño fue aumentándose hasta llegar a un 50% de cada una. 

Lo que produjo una transición de orden cristalino a estructuras amorfas ya que las de menor 

tamaño influyeron en la dinámica del sistema impidiendo que estas se reacomodaran de 

manera regular.  
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Por último, se colocaron semillas de 7 y 4 cuentas en la superficie de análisis las cuales 

ocasionaron una disminución en el tiempo de cristalización y en el caso de la semilla de 4 

partículas ésta influyó en el arreglo estructural, produciéndose dislocaciones lineales. 

 

En conclusión, el sistema granular se puede usar para modelar el proceso de cristalización bajo un 

campo magnético estable. La configuración experimental se puede modificar para modelar otros 

fluidos complejos ya que la concentración de partículas, la "temperatura" y las interacciones 

adicionales se pueden controlar fácilmente. 

 

En cuanto a las perspectivas a futuro se observa que el sistema puede adecuarse al estudio de 

diferentes transiciones de fases, vítrea o cristalina, cuando el sistema fluido se enfría en distintas 

condiciones, ya que la configuración experimental permite aumentar la concentración de las 

partículas, su tamaño, la intensidad del campo magnético y la superficie.  

 

Se podría describir puntualmente el momento (tiempo y temperatura) en que se da la nucleación y 

las propiedades estructurales del núcleo formado, así como determinar el radio critico en el cual 

las colisiones de las partículas exteriores no destruyan el conglomerado inicial. También se podría 

implantar semillas con nuevas y diferentes formas a las ya estudiadas, para conseguir otro tipo de 

estructuras. 

 

La superficie puede ser modificada utilizando, por ejemplo, planos inclinados e implementando 

formas geométricas sobre el área de observación. También se podría agregarse una fuerza central, 

por medio de un imán, por debajo de la superficie, la cual, en el experimento eliminaría la necesidad 

de una amplia curvatura. Se espera que esta especie magnética extra atraiga las partículas al centro, 

promoviendo la nucleación o en algún punto la formación de cadenas. 
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APÉNDICE A 

Limpieza de imágenes en ImageJ  

 

Para abrir la secuencia de 

imágenes ir al menú   

File>Import>Image Sequence, 

aparece un recuadro con opciones 

determinadas, en el número de 

imágenes quedarán 100, inicia en 

1 y en incremento 1, solo quedará 

activa la casilla Sort names 

numerically. Pulsar Ok. 

 

 

 

Posteriormente marcar la 

sección a analizar con la 

herramienta *Oval* para 

excluir los bordes. Ir al menú 

Edit>Selection>Create Mask. 

 

 

 

 

En Process seleccionar Image 

Calculator, aparece un recuadro: 

la primera opción queda 

predeterminada, en Operation 

elegir Tranparent-zero, Image 2 

elegir Mask queda marcado 

Create New Window y dar Ok.  
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Después ir a menú 

Process>Binary>Make Binary, 

en el recuadro en la opción 

Method se queda la que 

aparece determinada (Default) 

y en Background elegir Ligth, 

desmarcar Calcuate treshold 

for each image, y dar click en 

Ok. 

 

 

Por último, ir nuevamente a 

Process>Binary y elegir 

Watershed, para separar las 

partículas que pudieron haber 

quedado juntas y que se 

muestran como una sola.  

Aquí el proceso de limpieza ha 

concluido. 
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Polígonos de Voronoi en ImageJ 

 

Previamente la secuencia a 

examinar debió haber 

pasado por el proceso de 

limpieza, después ir a 

Process>Binary>Voronoi. 

En la ventana siguiente 

indicar que si procesar los 

100 cuadros. 

 

 

Una vez completado el 

proceso aparecen ya los 

polígonos correspondientes 

a la secuencia de imágenes, 

pero con mucho brillo, para 

arreglarlo ir al menú 

Image>Adjust>Threshold. 

 

 

 

Aparecerá la ventana de 

Threshold, ahí arrastrar las 

barras hacia el lado 

izquierdo, las demás 

opciones quedan tal cual, dar 

click en Apply y Ok. Las 

imágenes adquieren un 

fondo negro y los polígonos 

de color blanco. 
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 Para obtener las propiedades de 

los polígonos ir a 

Analyze>Analyze Particles, en 

la ventana siguiente el tamaño 

de particula queda el 

predeterminado al igual que la 

circularidad, y en Show 

seleccionar Masks. Marcar las 

casillas Display results, Clear 

results, Summarize y Exclude 

on edges,  y pulsar OK.  

 

Se obtienen dos tablas con las 

dimensiones área, diámetro, 

etc. de los polígonos de 

Voronoi, estas deberán ser 

almacenadas para graficar. Así 

también aparecen los poliedros, 

pero sin los diagramas del 

exterior.   
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Obtención de trayectorias de las partículas en ImageJ 

 

Una vez seleccionada la secuencia a analizar y de haber realizado el proceso de limpieza 

(previamente descrito). 

 

Ir al menú Analyze>Analyze Particles, 

aparecerá un recuadro, en el tamaño 

(pixel al cuadrado) colocar de 0-100, la 

siguiente opción se queda igual y en 

Shows elegir Masks. En cuanto a las 

casillas quedaran marcadas: Display 

results, Clear results, Summarize y 

Exclude on edges, dar Ok. 

 

 

Enseguida se obtendrán una tabla 

con datos sobre las partículas 

como área, perímetro, ángulo y 

posiciones de cada una de las 

partículas en cada imagen. Y la 

otra tabla contiene un resumen de 

las propiedades de partículas en 

conjunto por cada cuadro. Esta 

información puede ser 

almacenada o solo se cierran las 

ventanas. 
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Ir a Plugins>Mosaic>Particle 

Tracker 2D/3D, aparece una 

ventana en donde hay que teclear lo 

siguiente: Radius-6, Cutoff-0, 

Per/Abs-0.10000, Link Range-1, 

Displacement-20. Marcar la casilla 

Absolute y dar en Preview 

Detected, aquí las partículas son 

remarcadas en color rojo y se 

indica cuantas son. Pulsar OK. 

 

Cuando todo el proceso se ha 

realizado aparece el siguiente 

recuadro que indica cuantas 

trayectorias se encontraron, la 

opción de verlas y de abrir la 

tabla con las coordenadas de 

las posiciones de las 

partículas. Presionar 

Visualize All Trajectories y 

aparecen en distintos colores. 

 

Al dar click en All Trajectories to Table 

aparece una tabla como la siguiente con 

todos los datos sobre las trayectorias de 

las partículas, que servirá para la 

obtención del desplazamiento 

cuadrático medio. Esta debe ser 

guardada y el proceso ha terminado. 
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Función de distribución radial en ImageJ 

 

La función de distribución radial para las secuencias se realiza una vez limpiadas las imágenes. 

 

Posteriormente ir a 

Plugins>RadialDistrutionFunction, en 

el recuadro que aparece las opciones 

quedan tal y como están y pulsar Ok. 

 

 

 

 

 

 

Cuando ya se ha dado todo 

el proceso se obtiene la 

gráfica correspondiente a la 

g(r) de la secuencia 

analizada. Presionando List 

se muestran los datos que 

constituyen la gráfica. En 

File dar click en Save para 

alamacenar los datos. 

 

 


